
 

 

Introduction  

Mail merge is a very important facility provided by word processors, especially in the world of business and 
commerce. A single document (often a letter) is merged with a data set (often names and addresses) to produce 

several documents, each of which is personalised using information from the data set. At home this often arrives 

in the post as junk mail, but it could equally be a valid letter - eg a bank statement or reminder of a hospital 
appointment. A secretary at the bank/hospital hasn't typed out your letter personally; instead, they have used 
a mail merge to combine a standard letter and your details (probably along with those of other clients) to 
produce one or more letters at the same time.  

Mail merge can work with any dataset. The data may be held in a database, in a spreadsheet, in a table in a 
document or a list of email contacts. You can even use tab-separated values in a very simple text file. This is 
then combined with a Word document which contains fields. The fields match the column headings in the table 
or spreadsheet.  

The aim of this document is to remove the mystery surrounding mail merge and to show you the facilities 
which Word provides to help you.  
Creating a Data Set  
As mentioned above, the data for a mail merge often comes from an outside source such as an Access database, Excel 
spreadsheet or your Outlook contacts. You will be looking at these types of data source later. As an introduction to mail 

merge, create your own simple dataset as follows:  

1. Start up Microsoft Word as usual (or press <Ctrl n> for a new document if it’s already running)  

2. Type in the following field headings, pressing <,>  (or <Tab>) between each entry:  
      Title, First Name, Family Name, Department  

3. Press <Enter> for a new line then type in a row of data (eg your own details) pressing <,> between each field (ie Mr, 

John, Smith, French)  

4. Repeat step 3 with the details of one of your friends/colleagues  

5. Continue adding data for other people if you like (though 2 records is enough to demonstrate a mail merge) - don't 

press <Enter> at the end of your last line of data  

6. Press <Ctrl s> for [Save] and call your file data  (press <Enter> for [Save])  

7. Now press <Ctrl F4> (or move to the FILE tab) to Close your document (but leave Word running)  

Creating the Merge Document  
You next need to create the merge document - here, a memo to be sent out to all those in your data file. In order to be 

able to enter field codes representing the data, you first have to associate the two documents together. You can, of course, 
write the bulk of the text without the codes (or use an existing document) and then add the codes later. Let's do that here:  

1. Press <Ctrl n> to create a new blank document  

2. Type Memo to: then press <Tab> followed by <Enter>  

3. Type Department: then press <Tab> followed by <Enter>  

4. Click on the list arrow attached to the [Borders] button (in the Paragraph group) and select Horizontal Line  

5. Press <Ctrl r> (for [Align Right]) then move to the Insert tab and click [Date & Time] in the Text group – turn on the 

Update automatically option if you always want today’s date  

6. Select your preferred format from the Available formats: list then press <Enter> for [OK]   

7. Press <Enter> for a new line, press <Ctrl l> (for [Align Left]) then press <Enter> again  

Now type in the following memo (or something similar):  

8. Type The next meeting of the Committee is on Friday at 2:00pm.   

9. Press <Enter> then sign off with your name  

Your document is now ready for data field codes to be added and for the merge to be carried out.  
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The Mailings Tab  

  
There are two ways to carry out the mail merge - you can take command of the process yourself using the buttons on the 
Mailings tab on the Ribbon or you can seek the help of a Wizard.   

Try using the buttons first (working across the Ribbon from left to right).  

1. Move to the MAILINGS tab then click on the [Start Mail Merge] button and choose which type of mail merge you want 

– here, choose Letters  

2. Click on the [Select Recipients] button and choose Use Existing List …  

3. Click on the Documents button on the left side of the Select Data Source window  

4. Select the file data.docx then press <Enter> for [Open]  

Nothing appears to have happened but your data file is now associated with the current document.   

Press <Ctrl Home> then <End> to move the typing position after Memo to:  

5. Click on the words of the [Insert Merge Field] button in the Write & Insert Fields group and select Title   

6. Repeat step 6, choosing First Name then Family Name   

7. Press <Esc> to [Close] the Insert Merge Field window then type in spaces between the fields  

8. Press <down arrow> to move down to Department: then repeat step 6, this time choosing Department   

9. Move the typing position down to the start of the first (blank) line of the memo (before The...)  

10. Repeat step 6 again for the First Name then press <Esc> and type a ,  

11. Your document is now ready for the merge - click on the [Preview Results] button   

Your data fields are now replaced by real data. To the right of [Preview Results] is the [GoTo Record] button (currently 

displaying record number 1). To the left and right of this are buttons for [Previous Record] and [Next Record] (and [First 

Record] plus [Last Record]).  

12. Use the [Next Record] and [Previous Record] buttons to view the other memos  

Once you have checked the merged memos are correct you have a choice of either sending them directly to the printer or 

storing them in a new document.   

13. Click on [Finish & Merge] then choose Edit Individual Documents… - the following window appears:  

   

You can now decide whether you want to have all 
the memos (records) or just some of them. You get 
the same dialog box if you choose Print 

Documents….  

14. Accept the All option - press <Enter> for [OK]  

A new document called Letters1 appears, with each memo on its own page (a Section Break (New Page) separates 
them). You can edit the individual memos if you need to - try adding a postscript to one.  

16. Press <Ctrl F4> to [Close] the document, saving it as invites  

17. End by clicking on the [Preview Results] button to turn this off and return to the data field codes in your 

merge document  

Modifying the List of Recipients  
If you don't want all the records in your data 

file used in the merge (or, indeed, if you want 

to add further people), you can select the 

records you do want via the [Edit Recipients 
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List] button: 1. Click on [Edit Recipients List] - 

the third button in the Start Mail Merge group  

The following window appears:  

 

  

To change any of the data or add a new recipient (or 

delete an existing one):   

2. Click on the data file in the lower Data Source 

box then on the [Edit...] button - a Data Form 

appears  

3. Click on [Add New], type in the data for the new 
recipient then click on [Close]  

4. Remove the tick from the check box in the top 
row (you don't need to send yourself a memo - 
this is how to remove individual recipients from 
the mail merge)  

5. Click on [OK] then on [Preview Results] - note 
that record 1 is missing but that an extra memo 
has been added for the new recipient  

6. Click on [Preview Results] again (there's no 
need to [Finish & Merge])  

7. End by closing the file – press <Ctrl F4> (or move 

to the File tab and choose Close)  

  

8. When asked, save the changes you've just made to your data file (press <Enter> for [Yes]) and save the merge 
document as memo  

If you open up your data file, you will find that the extra record has been added and that your own record is still 
intact - turning off the check box doesn't delete the record from the file (you would have had to use the [Delete] 

button on the Data Form to do that). To see this:  

9. Move to the FILE tab, choose Open then select data.docx from the list of Recent Documents  

Note how double quotes have been placed around the data for the extra recipient. In this simple comma 
separated file, these cause no problem. If, however, the text is converted to a proper table then they do appear in 

the merge:  

10. Press <Ctrl a> to select all the data  

11. Move to the INSERT tab, click on the [Table] button and choose Convert Text to Table...  

12. Press <Enter> for [OK] and the text becomes a proper table  

When performing a mail merge, people often create tables like this in which to store their data. As you have 

already seen, you don't have to do this - but it can simplify data entry. To check that the mail merge still works:  

13. Press <Ctrl s> to save your new layout   

14. Move to the FILE tab, choose Open then select memo.docx from the list of Recent Documents  

15. Click on [Yes] when a warning message (about an SQL command) appears – this is normal  

16. Move to the last record and note that the double quotes now appear   

17. Move to the data file via the Task Bar then press <Ctrl h> for [Replace] and set Find what: to “ – click on  

[Replace All] then press <Enter> twice (for [Yes] and [OK]) followed by <Esc> for [Close]  

18. Press <Ctrl F4> to close the data file – press <Enter> to [Save] the changes  

The Address Block and Greeting Line  
Word provides two special codes (Address Blocks 
and Greeting Lines) to allow you to insert multiple 

data fields (rather than having to add each 

individually, as you did above):   
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1. Move to the MAILINGS tab and click on 

[Preview Results] to turn this off and return to 

the codes  

2. Remove some of the current codes - drag 
through the three codes after Memo to: and 
<Delete> them  

3. Next click on the [Address Block] button in the 
Write & Insert Fields group  

  
In the box on the left, you can choose various 

formats for the recipient’s name – here, Mr. Joshua 
Randall Jr. is fine. Only the name appears in the 

Preview area even though Insert postal address is 

clicked on. Depending on what you’ve used for your 

column headings, even the name might not appear. 
To rectify this:  

4. Click on [Match Fields...] – the following dialog 

box appears:  

   
You’ll see that Family Name has been matched 

correctly to Last Name and that the two fields above 
have also been matched too. The other fields are 

not matched, however, but it’s easy to do so:  

5. Click on the arrow to the right of Company and 
choose Department  

Note the option to Remember this matching for this 

set of data sources on this computer. If you turn this 

on then you wouldn’t need to Match Fields if you 

were to use the same data file with another merge 
document.  

6. Press <Enter> for [OK] to close the Match Fields 
dialog box  

The Preview now shows the department from your 

records (which you don’t want).  

7. Turn off the Insert company name: option then 
press <Enter> for [OK] - the block is added to 
your memo  

Each Address Block can be customized and you can 
use this method to insert different fields at various 

locations in your document. Try adding another 
block for the Department:  

8. Remove the current code by dragging through 
<<Department>> and pressing <Delete>   

9. Click on the [Address Block] button and, this 

time, turn off both the Insert recipient’s name … 

and Insert postal address options  

10. Press <Enter> for [OK] to insert the new block  

11. Click on [Preview Results] to see the result then 
again to return to the codes  

In this particular example, it would have been easier 

to use the Department field directly, but it does 

show you what can be done. Also, you didn’t have to 
turn off the Insert postal address option because the 
fields don’t exist here.   

Next, add a Greeting Line:  

12. Move down to the start of the memo and 

<Delete> the first line (<<FirstName>>,)  

13. Click on the [Greeting Line] button in the Write 
& Insert Fields group – a dialog box appears as 

below:  
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14. Using the list arrow, change Dear to To:  

15. Also, change Mr. Randall to Joshua then press 

<Enter> for [OK]  

16. Click on [Preview Results] to see the result (use 

[Next Record] to move through the records) 
then [Preview Results] again to return to 
viewing the codes  

You’ve finished seeing how the buttons on the 

MAILINGS tab work, so:  

17. Press <Ctrl F4> (or move to the File tab) and 

Close the memo file, saving the changes when 
asked  

The Mail Merge Wizard  
The Mail Merge Wizard takes you through the above process one step at a time; there are 6 steps in all. Once you 
are used to it, it makes mail merge even simpler. If you ever need to take control yourself then simply redisplay 
the toolbar and make the necessary changes using the buttons.  

1. Press  <Ctrl n> for a new document (a document must be open for the Wizard to work)   

2. Move to the MAILINGS tab, click on [Start Mail Merge] and choose Step by Step Mail Merge Wizard...  

The Task Pane appears on the right of the screen. This changes with each step, as shown below:  

1)   2)   3)   

 

4)   5)   6)   

 

Step 1: Setting Up the Document Type  

You haven't considered document type yet. Basically, mail merge can be used for different types of document 
including a letter/memo, a set of envelopes, an email, address labels and a list/catalogue (directory).   

The default type of document is a letter and, to keep things simple, that's what you'll create first:   

3. Leave document type as Letters - click on Next: Starting document at the foot of the pane  
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Step 2: Select the Starting Document  

In step 2 you can choose which document you want for your merge document. This can be an existing document 

(or template) or the current document.  

4. Leave starting document as Use the current document - click on Next: Select recipients   

Step 3: Select Recipients  

In step 3 you need to identify the data file containing the recipients. If no such file currently exists then you can 
create one - try this next:  

5. Under Select recipients click on Type a new list 

then Create... - a data form appears:   

   

This provides a list of the most likely fields you will 

be using - but it's set up for writing a letter and uses 
American field names. That's no real problem as you 
can customize the list to rename fields, delete ones 
you don't want and add new ones you do require:  

6. Click on [Customize Columns...] - another dialog 
box appears:  

   

7. Select Company Name then click on [Rename…]   

   

8. In To: type in a new name of Department then press <Enter> for [OK]  

9. Next, select E-mail Address and [Delete] it - press <y> for [Yes] to confirm this  

10. Repeat step 8 eight times to leave just the first four fields in the list  

11. Now create an extra field - click on [Add...]   

 

12. Type in a new field name Partner then press <Enter> for [OK]  

Note: Use the [Move Up] / [Move Down] buttons to alter the order of the fields on the form.  

13. Press <Enter> for [OK] again to return to the form then enter some data, as you did earlier, starting with 
yourself - for just some of the recipients include their partner's first name  

Tip: If you press <Enter> (or <Tab>) at the end of each form it takes you to the [New Entry] button. Press <Enter> 
again and you can enter your next set of data.  
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14. When you have added 3 or 4 recipients, click on [OK]  

15. Save the address list in My Data Sources, calling it newdata (press <Enter> for [Save]) - note that this file 

uses an Access database format  

16. The Mail Merge Recipients window now appears, allowing you to specify exactly which recipients you want - 
here, press <Enter> for [OK] to accept them all  

17. Move on by clicking on Next: Write your letter  

Step 4: Write Your Letter  

You now have to write your letter. Again, try writing a memo similar to earlier:  

18. Type Memo to: then press <Tab>  

19. In the Task Pane, click on Address block... – turn off Insert postal address then press <Enter> for [OK]  

20. Press <Enter> for a new line, type Department: then press <Tab>  

21. In the Task Pane, click on More items... to see the list of merge fields  

22. Select Department, press <Enter> for [Insert] then <Esc> to [Close] the Insert Merge Field dialog box  

Tip: It can be very annoying, having to close this dialog box each time you insert a field. Remember that you can 
always use the [Insert Merge Field] button on the Ribbon. In fact you can choose between the Ribbon and Task 
Pane Wizard for any of the commands.  

23. Press <Enter> for a new line then move to the Home tab, click on [Borders] and choose Horizontal Line 24. 

Next, click on Greeting line... in the Task Pane  

25. Change the format from Mr. Randell to Joshua and Cynthia then press <Enter> for [OK]   

26. Press <Enter> then type in a short memo: Don't forget the meeting on Friday.  

27. Again, press <Enter> then sign off with your name   

28. Move on by clicking on Next: Preview your letters   

Step 5: Preview Your Letters  

The fifth step of the Wizard allows you to preview the results of the merge.  

29. Use the Recipient buttons in the Task Pane to move between the memos  

30. When you reach the memo to yourself, click on [Exclude this recipient] - you don't need one  

31. Click on Edit recipient list... if you want to make any further changes to the list of recipients - click on [OK] to 
return to the merge  

32. Click on Next: Complete the merge to move on  

Step 6: Complete the Merge  

The final step of the merge allows you to send the letters to the printer (Print...) or edit individual letters (as you 
saw earlier).  

33. Click on Edit individual letters... in the Task Pane  

34. Accept the default option All - press <Enter> for [OK]  

The merged memos appear in a separate file, Letters2, as they did earlier.  

35. Press <Ctrl F4> or click on the [Close] button – here, there's no need to save the file  

Changing the Data Source to an Access File  
At any time you can move backwards through the 

Wizard to change any of the settings. Here, try 

changing the data source to use a database:  

1. Click on Previous: Preview your letters then 

Previous: Write your letter and finally Previous: 

Select recipients  

2. At Step 3, under the heading Use an existing list, 
click on Select a different list...  
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3. Click on My Computer then choose Data (D:), 

open the folder Training and select 
example2013.accdb – press <Enter> for [Open]  

You now have a list of 390 imaginary students for 
the mail merge. The next section shows you how to 
select a subset of records from the list.  

  

Sorting and Filtering  
How can you select a subset of recipients from the list? For example, you might want to send a memo just to male 

students living in a certain Hall of Residence. Currently, the list is unsorted so you would have to work through the 
entire list to find the recipients you require. However, if the list were sorted by Hall of Residence, then all the 
records you would need would be next to each other. It's easy to sort the list - you just click on the column 
heading of the data to be sorted.   

1. Using the horizontal scroll bar, move the display to the right to see the Hall field  

2. Click on the Hall column heading then use the vertical scroll bar to check the results are sorted Note: If you 

click a second time, the records are sorted in reverse alphabetical order.  

Removing the ticks on the left for those records you don’t want can be very time-consuming. Sometimes it’s 
easier to remove all the ticks and then turn back on those records you want. To clear the ticks:  

3. Click on the tick used for the column heading (between Data Source and Surname) – the ticks disappear 4. 

Repeat step 3 to turn them all back on  

A better way to select just certain records is to use a filter:   

5. Click on the filter arrow on the left of the Title column heading and select Mr - only males are now shown  

6. Repeat step 5 but this time click on the Hall column's filter arrow  

7. Choose (Advanced...) - the Filter and Sort 

window appears (with the first filter already set) 

8. On the Filter Records tab, click on the list 

arrow for the second row Field: heading  

  

9. Select Hall from the list of available fields  

10. Under the Compare to: heading type in the required hall (eg Wantage)  

11. Click on the list arrow for the Comparison: heading - note what's provided but leave the setting as Equal to  

Note that you can set alternative filters using Or. If you wanted the male students from two halls you would need 
to set two further filters, one saying Or Title Equal to Mr and a fourth saying And Hall Equal to Windsor.  

Next have a look at the sort options:  

12. Click on the Sort Records tab:  

  

13. Click on the list arrow against Sort by: and change Hall to Surname   

14. Repeat step 13 for Then by:  and choose FirstName - here you can perform sorts within sorts   

15. Press <Enter> for [OK] to close the Filter and Sort window   

http://www.reading.ac.uk/web/files/its/example2013.accdb
http://www.reading.ac.uk/web/files/its/example2013.accdb
http://www.reading.ac.uk/web/files/its/example2013.accdb
http://www.reading.ac.uk/web/files/its/example2013.accdb
http://www.reading.ac.uk/web/files/its/example2013.accdb
http://www.reading.ac.uk/web/files/its/example2013.accdb
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The Mail Merge Recipients list has now been shortened to include just males in the chosen hall.   

16. Click on [OK] then on [Preview Results] - an error message appears:  

  

This is because there is no Department field in the new data source. You could replace it with another field (using 
the list arrow attached to the box provided) or remove it from the merge.  

17. Click on the [Remove Field] button to erase the field from the main document  

18. Use the [Next Record] and [Previous Record] buttons to view the memos  

Using an Excel File as a Data Source  
Currently, you are using an Access database for your data source but you can equally use an Excel spreadsheet. It 

so happens that the database had just a single table, so Word could identify the data source without asking. If the 
database has several tables/queries then you have to specify which one you want.   

The Excel file you are going to use has more than one worksheet, so you'll be able to see the extra step in this 

next example.   

1. Using the link provided in the Task Pane, click on Select a different list...  

2. Click on My Computer then on Data (D:) and double click on the Training folder to [Open] it 3. 

Select the file advanced.xls and press <Enter> for [Open] - the following screen appears:  

  

A similar window appears if your Access file contains more than one table or query. You now have to choose the 

source of the data. Not only is each worksheet in the file listed (these are denoted by $ signs), but each column 
heading too.  

4. Select the worksheet students$ then press <Enter> for [OK] - the list of Mail Merge Recipients appears (note 
that this is the same imaginary set of students used previously):   

http://www.reading.ac.uk/web/files/its/advanced.xls
http://www.reading.ac.uk/web/files/its/advanced.xls
http://www.reading.ac.uk/web/files/its/advanced.xls
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It so happens that this list is almost identical to the Access table used previously (though not all of the fields are 
included and it's sorted by surname). As such, the original merge should still work:  

5. Click on the [OK] button to see the merged memos then use the [Next Record] button on the Ribbon to view 

some of the merged records  

6. End by closing the file – press <Ctrl F4> or click on Close (there's no need to save the file)  

Labels, Envelopes and Directories  
The first step of the Wizard was to choose a document type. The default type is a Letter. In this next section, have 

a look at the other types:  

1) Labels  

If you want the mail merge to produce a set of labels 

then you proceed as follows:  

1. Press <Ctrl n> for a new starting document  

2. Move to the MAILINGS tab, click on [Start Mail 

Merge] and choose Step by Step Mail Merge 

Wizard...  

3. At step 1 of the Wizard, choose Labels then click 

on Next: Starting document 4. Click on Label 

options... to set up your labels:  

  

5. Change the Label vendors: (manufacturer) if necessary then select the correct Product number: (here choose 
Microsoft and 30 Per Page – the second one, ie 2.54cm x 6.67 cm) - press  <Enter> for [OK]  

6. Click on Next: Select recipients  

7. Use an existing list and click on Browse... to find it then on My Computer  

8. Select Data (D:) then double click on Training and then on example2013.accdb to [Open] it  

9. Click on [OK] to close the Mail Merge Recipients window  

A skeleton set of labels is displayed with all but the first containing the special <<Next Record>> code. Codes like 
this are dealt with in the final section of this document.  

10. Click on Next: Arrange your labels to move to step 4 of the Wizard  

11. Click on Address block... and turn off Insert postal address - press <Enter> for [OK]   

12. Press <Enter> for a new line then click on More items... in the Task Pane  

13. Choose Hall, press <Enter> for [Insert] then <Esc> to close the list of fields  
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You now have the correct field codes on the first label but the others are all empty. Were you to view the labels, 

just one label per sheet would show. The <<Next Record>> code moves on to the next recipient but no details are 

included on the label. You need to replicate the codes on each label:  

14. Click on the [Update all labels] button (or use [Update Labels] on the Mailings tab) - the field codes are 
copied to all the labels  

15. Click on Next: Preview your labels to view the actual labels  

16. End by closing the current document – press <Ctrl F4> or click on [Close] - there's no need to save it  

Note: If the addresses don’t fit onto a single label, you may need to change the paragraph spacing or font size 
after step 13.  

  

2) Envelopes  

A similar process to the above could be used to print mail merge data on a set of envelopes. There's no need to go 

through the whole process in these notes but it is worth looking at the initial steps:  

1. Press <Ctrl n> for a new starting document  

2. Move to the MAILINGS tab, click on [Start Mail Merge] and choose Step by Step Mail Merge Wizard...  

3. At step 1 of the Wizard, choose Envelopes then click on Next: Starting document  

4. Click on Envelope options... to set up your envelopes:  

The Envelope Options window has two tabs as shown below:  

 
   

On these you need to set up the correct Envelope size: and the Feed method for your particular printer. Note also 

the Preview envelope. This has an area for the Return address at the top left and for the Delivery address in the 
lower middle. You can change the settings for these if you need to.  

5. Select an Envelope size: of DL then press <Enter> for [OK]   

6. The current typing position is ready for you to type in your Return address (if you want one)  

7. Press the <down arrow> key twice to move the typing position into the text box provided for the Delivery 

address (lower centre of envelope) – or you could use the mouse to click in it   

You would now link in the data file and insert an <<Address Block>> but there's no need to continue here.  

8. End by closing the document – press <Ctrl F4> (or move to the File tab and choose Close) - there's no need to 
save it  

Note: Once you have set up the Envelope options for one mail merge, Word remembers the settings for future 
merges. Similarly, Labels options are retained from one merge to the next.  

3) Directories  

You can merge data into a list such as a catalogue or list of members.  Word calls such a document a directory. If 

you select this option at step 1 of the Wizard then you are forced into creating a new document at step 6 (you 
don't have the option of printing the merged records directly to the printer).  
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1. Press <Ctrl n> for a new starting document  

2. Move to the MAILINGS tab, click on [Start Mail Merge] and choose Step by Step Mail Merge Wizard...  

3. At step 1 of the Wizard, choose Directory then click on Next: Starting document  

4. Click on Next: Select recipients then Use an existing list and click on Browse... to find it  

5. Click on My Computer then on Data (D:); double click on Training, select example.accdb and [Open] it  

6. Click on [OK] to close the Mail Merge Recipients window  

7. Click on Next: Arrange your directory   

8. In the Task Pane, click on Address block... and turn off Insert postal address - press <Enter> for [OK]   

9. Type a , then click on More items... in the Task Pane  

10. Choose Hall, press <Enter> for [Insert] then <Esc> to close the list of fields  

11. Press <Enter> for a new line  

Your document is now set up for the merge. The list only shows when you get to the final step of the Wizard so, 
to speed things up, use the toolbar button to carry out the merge:  

12. Click on the [Finish & Merge] button and choose Edit Individual Documents… - press <Enter> for [OK] for All 

records  

You should find that you now get a list, with several records on each page.   

13. Close the merged file by pressing <Ctrl F4> or clicking on [Close] - there's no need to save it  

You could equally well have used a one-row table for your merge document, in which case you would now have a 

complete table. If you wanted your table to have column headings, you would add them to the final document, 
not the merge document. To see this:  

14. Press <Backspace> to delete the blank line – the typing position should be immediately after the <<Hall>> 

code  

15. Next, press <Ctrl a> to select the whole document  

16. Now move to the INSERT tab and click on [Table] and choose Convert Text to Table…  

17. Set the Number of columns: to 2 - press <Enter> for [OK]  

18. Move to the MAILINGS tab, click on [Finish & Merge] and choose Edit Individual Documents… - press 

<Enter> for [OK] for All records  

19. Now add the headings – right click in the top row of the table, choose Insert then Insert Rows Above  

20. Type the headings Name and Hall and apply any formatting (eg [Bold] and [Center])  

21. Move to the TABLE LAYOUT tab and click on Table Properties... and click on the Row tab  

22. Turn on Repeat as header row at the top of each page then press <Enter> for [OK]   

23. Scroll down your new document to see the results  

E-Mail Messages  
Mail merge can also be used to send emails to a list of recipients (eg from your Outlook contacts). The email 

addresses could also be in an ordinary data file – here we will use the Access database again:  

1. Press <Ctrl n> for a new starting document  

2. Move to the Mailings tab, click on [Start Mail Merge] and choose Step by Step Mail Merge Wizard...  

3. At step 1 of the Wizard, choose E-mail Messages then click on Next: Starting document  

4. Click on Next: Select recipients then Use an existing list and click on Browse... to find it  

5. Change Look in: to Data (D:) then double click on Training, select example2010.accdb and [Open] it  

6. Click on [OK] to close the Mail Merge Recipients window  



 

 

7. Type in a message then, to speed things up, click 

on [Finish & Merge] and choose Send Email 

Messages  

 
 

8. Set the To: to the Email field and fill in the Subject line  

9. You would now confirm you want to send the messages but, here, click on [cancel]  

10. End by closing the current document – press <Ctrl F4> or click on [Close] - there's no need to save it  

Word Fields  
Word has a small number of special field codes primarily for use with mail merge. You've already seen one 
(<<Next Record>>) but others allow you to type in additional data (ie not held in the data file) or display a 

particular data item only if it meets certain criteria.  

You should currently be looking at your directory list. If you only want a list of students who live in a Hall of 
Residence then you could either set up a filter on the Recipients List (as you saw earlier) or you could make use of 
another Word code:  

1. Click on [Close] to close it - there's no need to 
save the merged document  

2. Next, click on [Preview Results] to redisplay the 

merge codes  

3. Press <Ctrl Home> to move to before the 
<<Address Block>>  

4. Click on the [Rules] button on the Mailings tab 

and choose Skip Record If...  

5. Fill in the dialog box as below (ie change Field 
name: to Hall and Compare to: to Private):  

  

6. Press <Enter> for [OK] then on the [Finish & 

Merge] button and choose Edit Individual 
Documents…   

7. Press <Enter> for [OK] to see All the records - no 

students in Private accommodation are now 
listed  

8. Close the merged file by clicking on [Close] - 

there's no need to save it  

The list could be improved if the word Hall was 

added to each record where applicable (you 

wouldn't want Dunsden Hall, however, as it’s 
Dunsden Crescent). To achieve this you need 
another special Word field:  

9. Move the typing position immediately after the 

<<Hall>> field code and press the <spacebar>  

10. Now click on the [Rules] button and choose If ... 

Then ... Else ...  

11. Fill in the new dialog box as below - change the 

Field name: to Hall, Compare to: to Dunsden 

then Insert this text: to Crescent and 

Otherwise insert this text: to Hall   

  

12. Click on [OK] then on the [Finish & Merge] button and choose Edit Individual Documents…   

13. Press <Enter> for [OK] to see All the records  

14. Close the merged file by clicking on the [Close] button - there's no need to save it  


